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KLAVARSCRIPT 
Transcribing sheetmusic in traditional notation to Klavarscore 

 

Manual 
 

 

 

 

This manual consists of three parts: 
 

1 - Quick start 
This allows you to create a music piece in Klavarscore 

as quickly as possible. That is then in a simple version, 
to understand the software fully you need additional 

information from the other parts of the manual. 
 

2 - Toolbars and Context menu 

If you have opened KlavarScript, you will see a large 
number of buttons and menus. The operation of these 

is explained in this section. 
 

3 - Explanation and other topics 
This explains how you can perform certain operations 

and which buttons and menus you need for that. 
 
Note: 

To be able to transcribe sheet music in the 
Traditional Notation to KlavarScore, a good 

knowledge of the Traditional Notation is 
necessary !! 
 

 
 

©Adri Koetsier 
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TOOLBARS IN KLAVARSCRIPT 
 

 

 

Abbreviations: 

 

LMB  = Left Mouse Button              

RMB  = Right Mouse Button              

LH    = Left Hand              

RH    = Right Hand              

KS    = KlavarScript              

SN    = Standard Notation              

 

CONTEXT MENU 

If you place the cursor on an object and press the Right Mouse Button, you will get a list of possible 

operations of that object. 

 

LINKS 

The underlined PURPLE colored lines in the table of contents and text are links: if you click on 

them, you will go directly to the relevant chapter. 

 

KlavarScript version May 2022 (update to Windows 10/11) 

 

Rev. 06-221222 

 

Note: 

The development of KlavarScript is not yet fully completed; some operations do not work or do not 

work properly and can therefore inadvertently change the note image. This is indicated in red. 
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1  QUICK START WITH KLAVARSCRIPT 
 

1.1 If you enter the notes yourself 
 

You can use the arrow cursor to pinpoint the location where an object is to be placed or the 

object to which an operation must be  performed. 

 

Select the staff 

Open KS and click on "File"→"New". In the "Select template" menu, select the right type of staff. 

If you find the characters too small, you can set the zoom factor to 150% in the "View toolbar". 

  

Select Measure 

KS starts with bars in 4/4 size, but you can also choose another size: 

Click on "Layout"  "Meter and Tempo". Check the box "Change time signature" and enter your 

choice. 

The playback tempo and key signature can be set later. 

 

Enter notes 

 

quarter note   First select the shortest note you want to enter in your piece of music in the 

                     "Edit toolbar" shown here (you can change it afterwards). 

8th note  

 

16th note 

 

32nd note 

 

The notes can be placed anywhere 

 

 

For this, also see the chapter on Grid. 

 

In the "Edit Toolbar" click on the button , move the cursor to somewhere in the staff,  click on 

the RMB and choose under "Input" whether you want to enter notes for the Left or Right Hand. Move 

the cursor to the place where you want to put the note and click on the LMB. You don't have to go to 

this "context menu" for every note, but only when you want to change the stem direction. 

If you later want to change the direction of the stem, position the cursor on the note until a square 

dotted block appears around the note and press the space bar. Or: click on the RMB. Then choose 

"Move to part" and make your choice. 

 

Delete notes 

Put the  cursor on the note and click on the LMB. Then click on the RMB and choose "Delete". 

Or: put the cursor on the note and press the "Delete" key. 

 

Continue with Chapter 1.3 Formatting Sheet Music 

 

 

1.2 If you use a Source file 

Select a File 

First: make sure you have a suitable .XML or .MID file. 

The .XML files that come from other notation programs are usually usable, but .MID (= MIDI) files 

are not always suitable. In many MIDI files, especially those from the internet, the notes are all 

slightly shortened. During playback, this sounds better, but in KlavarScript you will be met with an 

abundance of unnecessary stop signs. Minor shortcuts can be corrected by KS (see later in this 

manual under “Edit→Quantize and Trimming”), but if the shortening is too large then the file is not 

suitable. Unfortunately you cannot see in advance if a MIDI file is suitable, so just try. 
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Load a file 

Open KlavarScript, click on "File" and then "Open". In the window that you see you can look up the 

requested .XML or .MID file. Activate the file name and click on "Open". 

 

 

1.3 Format Sheet Music 
Symbols 

In the menu on the right of your music page you will find the "Symbols Window", which contains 

various groups of symbols to place in the music bars. See also chapter 2.6 Symbols Window 

 

Key signature 

If you have used an XML file, the key signature will often be indicated automatically. If you have 

used a MIDI file, you must determine the key signature yourself. 

In the "Symbols Window" click on the + in the square box before the title "Keys", there you will find 

symbols for the various types of scales. The required symbol must be placed on the root of the 

relevant scale, you can choose which root, depending on the space in the score. Move the cursor to 

the relevant symbol and drag it with the LMB pressed to the desired location. 

 

Repeats 

Repetitions are indicated in Klavarscore in the same way as in the Traditional Notation. 

Click in the "Symbols Window" on the + in the square box before the title "Measure symbols", there 

you will find all symbols to indicate repetitions. Move the cursor to the relevant symbol and drag it 

with the LMB pressed to the desired location. 

 

Title block 

The Title block is the part at the top of the first page of your sheet music where the name of the 

piece of music and the other information should be. Click on "Layout" in the "Menu toolbar" and then 

choose "Title and copyright". In the "Document Properties" window you can enter the necessary 

data, then click on "Insert in document". This data is now placed on the upper part of the first page. 

You can easily move the texts in the title block, and if you find the block too large, you can make it 

smaller as follows: click in the "Edit Toolbar" on the top "txt" button, the frame of the block will now 

be visible . You can adjust the size with the cursor on one of the square blocks in the border. 

 

Page numbers 

Click in the "Menu toolbar" on "Layout" and then choose "Page numbers and margins". 

In the lower part of the "Page setup" window, click behind the "Position" on the black arrow down. 

You can then choose from various locations for the page numbers. It is also useful to indicate the 

total number of pages of this piece of music and possibly the file name. You can do this by entering 

the following in "Format": 

Page% p/X File name.mid %p is then automatically replaced by the page number, X is the number 

of pages that you have to fill in yourself. You can also enter the file name if you wish. 

 

Measure numbers 

Click on "Layout" and then choose "Measure numbers". You can make your choices in the window 

that appears. It is useful to place many measure numbers during the layout of your piece of music, 

for example every two or three measures; that saves a lot of counting. Later you can change that to 

only "At the top of every bar". 

 

Save file 

Select "File" → "Save as". KS takes the title of the piece you just specified as the file name, but you 

can also choose another name. The KS document is saved as a MIDI file, you can play it with any 

available Midi player. It is not possible to save the document as a .XML file.  
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2 TOOL BARS 
 

For the name of the various bars, see the illustration on page 2. 

 

2.1 MENU TOOLBAR 
 

2.1.1 Toolbar File 
These are the usual Windows commands, therefore they are not discussed here. 

 

 

2.1.2 Toolbar Edit 
First you see the usual Windows commands, therefore they are not discussed here. 

 

Quantize and trim 

The "Quantize and Trim" functions can be used if you play the music directly with a keyboard, digital 

piano, or electronic organ. In this case the notes are not all neatly placed in the right place, and the 

length is sometimes not as you intended. 

 

First select the group of notes you want to Quantize or Trim by drawing a "rectangle" around these 

notes with the cursor or select all notes by pressing Ctrl/A. 

 

"Quantize, Start time": The beginning of the notes is placed in the right place. 

With "Quarter count", the starting position is a very multiple of a 

quarter count. 

"Quantize, Duration": The notes get the correct length. With "Quarter count" the length 

is a very multiple of a quarter count. 

"Trimming notes"  Not yet implemented 

 

Set velocity 

This allows you to set the velocity for each note or set of notes for playback. 

Select a note or group of notes and choose “Edit”  “Set velocity”, Enter the "New velocity" and 

click OK. You can set a values from 0 (soft) to 127 (loud). 

 

Transpose Selection 

Note: with this operation the notation and the MIDI notes are changed. Select the notes that you 

want to transpose. Go to "Edit"→"Transpose" and indicate which shift you want. 

 

Merge 

All selected notes are assigned to a newly formed part, see "List of parts". 

 

Parts 

With this you get the menu "Part Overview" 

Also: Press  . See further at "View toolbar". 

 

Music elements 

This gives you the "Elements List" menu 

Also: Press . See further at View toolbar. 

 

 

2.1.3  Toolbar View 
Page Mode  Not yet implemented 

Scroll mode Not yet implemented 

 

Toolbars 

These allow you to enable or disable the various toolbars. You are recommended to leave them all 

on. 
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2.1.4  Layout 
Select Template 

Here you can set the type of music bar that you will use. Click on a type bar and then on OK. 

Also: Press . See further at View Toolbar. 

 

Page numbers and margins 

Margins for Staffs / Margins for text 

This sets how much white space you want around the bars and at the edge of the paper. 

 

Page numbering 

In the lower part of the "Page setup" window, click behind the "Position" on the black arrow down. 

You can then choose from various locations for the page numbers. It is also useful to indicate the 

total number of pages of this piece of music and possibly the file name. You can do this by entering 

the following in "Formatting":  Page%p/X__File name.mid . %p is then automatically replaced by the 

page number, X is the total number of pages that you have to fill in yourself, you must also enter 

the file name here yourself. If you enter%f instead of “File name.mid”, the file name and path will 

be filled in automatically.  

 

Measure distribution 

The normal size of a quarter note is 7.5 mm. 

You get here the menu "Change KS: Measure Setup", in which you can set the size of one beat 

(quarter note). 

We strongly advise to check the box  "Do not stretch measures". In this case all equal notes 

will have the same length on paper. This fits better with the way you read Klavarscore. 

However it is possible that Klavarscript makes beams of unequal length. You can prevent this by: 

- Make the "Title and Copyright" block so that the bottom line of that block is slightly above 

  the small line above the "txt" push button, and: 

- Use the "Staff break" symbol from the "Measure symbols" list for each bar, and: 

- Experiment with this. 

 

If one of the other boxes is checked, the length may be increased to create a full bar or page. In 

that case it is possible that measures will get unequal lengths, that makes it more difficult to play at 

the right tempo 

 

Measure numbers 

You can specify your choices in this window. It is useful to place many measure numbers during the 

layout of your piece of music, for example every two or three measures; that saves a lot of 

counting. Later you can change that to only "At the top of each bar". 

 

Meter and Tempo 

The tempo setting of the playback tempo is only important for playback. 

 

Title and copyright 

In the "Document Properties" window you can enter the necessary data, then click on "insert in 

document". This data is now placed on the upper part of the (first) page. 

 

2.1.5  Tools 
Setup MIDI devices 

Here you can select the MIDI input and output devices. 

 

Options 

The line thickness setting is immediately visible, the setting of the symbol size is only visible with 

the next file that is loaded. These two settings have no effect on the stored files. 

 

2.1.6  Window 
In KlavarScript you can open and edit several files at the same time. In this menu you can arrange 

them as you wish. However, you can also open several different files one after the other via the 

“File” menu. 

 

* * * * * * * * * * * 
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2.2 EDIT TOOLBAR 
Which of the buttons is selected is indicated by a blue border. 

 

2.2.1 Cursor 

The cursor allows you to identify the subject on which an operation is to be performed. 

 

Activate  

Point to a note or text with the cursor; a dotted square appears around the note; that disappears 

when the cursor is moved. 

 

Select 

Pointing at an object (notes or characters or text) with the cursor and then clicking with the LMB; 

the dotted square now becomes a blue square. This disappears when you click somewhere else. 

A group of objects can be selected by drawing a rectangle around it with the LMB pressed. After 

releasing the LMB, the objects turn blue. You can select a number of random objects one after the 

other by clicking on the individual objects with the Ctrl key pressed. 

Cancel selection by clicking somewhere else with the LMB. 

 

 

2.2.2  Measures 
Select measures 

Click on "Select measures" and select the measures on which you want to perform an operation 

(now turns blue), select the part with the cursor from top to bottom. 

Then click on the RMB and choose an operation in the context menu. 

 

Cut / Copy 

These are the usual operations in Windows, which are performed here on the selected part. 

 

Insert 

A measure or part of a measure (as large as you have selected) is added above the selected part. 

 

Remove 

The selected part is deleted, the lower part of the bar is moved up. 

 

Tempo 

You can change the playback tempo of the selected part. 

 

Time signature 

You can change the time format of the selected part. 

 

Size 

Select the distance in mm between the notes, only for the selected part of the measure. 

See also 2.1.4 “Layout”, "Measure distribution". 

 

Other 

The other options of the context menu are not relevant here. 
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2.2.3 Notes 
Place notes 

Click on "Note Edit" when you want to add or change notes. Move the cursor to the place where 

you want to put the note, and click on the RMB (context menu) if you need to change the direction 

of the note stem, you can change this here; or click on the LMB to place the note. 

 

Delete notes 

Put the cursor on the note and press the LMB. Then click on the RMB and choose "Delete", or put the 

cursor on the note and press the "Delete" key. 

 

Insert or move notes 

Click on "Note Edit" if you want to add or move notes. 

 

Change notes 

Activate the note that you want to change, leave the cursor on that note and press: 

S  change the normal note to a grace note (and vice versa) 

M   change normal note to ossian note (and vice versa) 

L  change ordinary note to large note (and vice versa) 

T   transpose the note one octave up  

Shift + T transpose the note one octave down 

O  add a copy of the same note one octave up 

Shift + O add a copy of the same note one octave down. 

 

2.2.4 Split in Parts 

Split parts 

If there are two parts on a staff (eg. Left hand and Right hand) then these parts are distinguished by 

the "Stem direction". Changing the stem direction, therefore, means that the note is brought to the 

other part. 

Note: 

The operation with this pushbutton sometimes does not work properly and can inadvertently disturb 

the note image. It is therefore better to use one of the methods as indicated in Chapter 3.3 Notes 

 

 

2.2.5 Stem connection lines 
Change connection lines 

Select the "Stems and beams etc." symbol . Activate with the cursor the stem of the note whose 

connection line you want to change and click with the RMB on the change that you want to make. 

" One-off" means: only for this one note's connection; 

" Standard" means: for the entire piece of music. 

 

Connection lines between the stems 

The Connecting lines are placed automatically by KS. You can make certain changes to this, but 

notice that once you have deleted a connecting line, an instruction is placed in the “Element List”. To 

restore the old situation this instruction should be removed as follows: 

 

Reapply connecting line 

If you change or delete a connection line, an instruction “KS:Connection” is placed in the “Element 

List” (see chapter 2.4.3). If you remove this statement, the original situation will be restored. To 

delete the instruction: select the instruction and click “Delete” at the bottom of the “Element” 

window. 

Connection lines for triplets 

If triplets exist in the source file, then KS sometimes does not display them correctly: i.e. the 

connecting line is not correctly connected to the three notes. It is then best to remove the notes 

from the triplet and place a new triplet as indicated in Triplets and other antimetric figures. 
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Removing connecting lines 

Choose the symbol  in the “Edit Toolbar”. With the cursor, activate the stem of the note whose 

connecting line you want to remove and click with the RMK on “Separate note stem”. 

 

 

2.2.6 Floating Textblock 
For the title and other details on top of the first page of your piece of music, see chapter 2.1.4 

“Menu Toolbar”→“Title and copyright”. 

 

Floating Textblock 

If you place text somewhere in the music bar, the music bar is initially interrupted, the part below it 

moves. Below is indicated how you can change this. When you change the measure length, the 

textblock stays on its place on the page. 

If you want to place some additional text somewhere, click on the “txt” button . Draw a 

rectangle, large enough to place your text where you want the text to appear with the cursor. A 

"Rich Editing" window will also appear in which you can specify the font, size, style and alignment. 

Then enter your text, possibly several lines. Then click on the cursor button. The "Rich Editing" 

window disappears, but all text blocks are still highlighted. You can now make the text blocks larger 

or smaller and move them as required. Then click the cursor button again. 

If you want to place extra text within the "Title and copyright" block, you must first create the text 

block outside (in the music). You can then move it to a location in the "Title and Copyright" block. 

You can still move all text blocks afterwards by placing the cursor on them and moving them with 

the left mouse button pressed. You can change the size of the text block afterwards by clicking on 

and with the cursor on one of the black blocks to move the frame. 

 

Delete text block 

Click once on the text block, with the RMB (you will get the "Context menu") and choose "Delete". 

 

Changing text and placement 

Put the cursor on the text and click on the RMB, you will now get the "Context menu" 

Edit:        Edit text and alignment. 

Wrapping mode:  "Wrap measures around text" means: the bar is interrupted by the text block 

        "Float over text" means: text IN the music 

      "Float over text with solid background"  means: IN the music with white 

       background. 

 

Stick to:     "Current page only" means: text only on this page 

      "Every other page"  means: text only on even or odd pages. 

      "Every page" means: text on every page, in the same place. 

 

 

2.2.7 Text anchored to timestamp 
For the title and other details on top of the first page of your piece of music, see chapter 2.1.4 

“Menu Toolbar”→“Title and copyright”. 

 

If you place the anchored textblock somewhere in the music bar, that part of the notes will be 

covered . When you change the measure length, the textblock stays on its place in the bar. 

For the other options, see Floating Textblock. 

 

 

2.2.8 Songtext 
Lyrics 

With "Lyrics" the words or syllables are linked to specified notes. 

Click on "Add lyrics" (F9). 

You can enter the full text of the piece in the "Insert lyrics" box that appears. If each syllable of a 

word must be assigned to its own note, you can separate the syllables with a hyphen, such as here: 

hyp-hen. You can also copy the text to this box from a word processor. 
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Now point with the cursor to the note where the first word or syllable must be placed and click on 

the LMB. You now see that the word is placed next to the bar at the designated note, and that it has 

disappeared from the box. Proceed in the same way to add the remaining words/syllables. 

Press the cursor to interrupt or end the procedure and the "Insert song" box will disappear. In the 

pull-down menu of the “Insert lyrics” block, you can choose the location of the text from a list of 

default score feature positionings. 

If you want to move the words a little, for example because they have a different character, you can 

activate them with the cursor and move them with the "Shift" key pressed. 

You will have to enter the lyrics of the following couplets elsewhere, only one singing text can be 

entered per part. 

 

Change font 

If you want to change the size and/or type of the lyrics: click on a word with the RMB and choose 

"Edit profile". In the "Customize KS: Profile" block, press the "Font" button. You can make the 

adjustment in the block that appears. This change applies to all the lyrics in the piece. 

 

 

2.2.9 Add measure at the end of the file 

Click on . 

 

 

2.2.10  Grid - The minimum distance between notes 
The notes cannot be placed on the beam at random places, but only on the "grid". This grid is an 

invisible vertical distribution of the staff that ensures that the notes are all neatly aligned. The step 

size, the distance between the grid lines, can be set with the buttons on the "Edit Toolbar" indicated 

on the left. 

 

"1"  Means that the shortest possible note is a quarter note. 

 

"2" Means that two eighth notes can also be placed on the space of a quarter note. 

 

"4" Means that four sixteenth notes can also be placed on the space of a quarter note. 

 

"8" Means that in the space of a quarter note, eight thirty-second notes can be placed on 

     the space of a quarter note.. 

"0" means that there is apparently no grid, and the notes can be placed anywhere. 

 

 

See also chapter 3.1 GRID 

 

 

2.2.11 Triplets and other antimetric figures 

Click on "Note Edit" and then on "Antimetric figures". Indicate in the selection menu with 

how many notes and over what duration, e.g.  three counts to a quarter note. Now place the first 

note of the figure in the right place, the others come underneath, but perhaps not yet at the right 

pitch. Click again to deactivate this function and click   . You can then move the notes to 

their correct position (pitch). 

If the first note of the antimetric figure is a continuation of the previous note, you can delete that 

first note in the usual way. The relevant part of the connection line remains. 

 

Sometimes an antimetric figure with many notes does not draw the correct number of notes, but it 

does state the correct number. This has to do with the minimum number of "ticks" per note, see the 

description "Grid". 

 

* * * * * * * * * * * 
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2.3 FILE TOOLBAR 
This contains the file operations that you find in all Windows programs. That is why they are not 

dealt with here. 

 

* * * * * * * * * * * 

 

2.4 VIEW TOOLBAR 
 

2.4.1  Parts button  
With this you get the menu “Part Overview”, in which you can see how the notes are distributed 

among the parts. 

Most pieces of music are divided over a number of "Parts", for example, Piano music will often 

consist of two parts, the Left Hand and the Right Hand, but additional parts for solo instruments may 

also have been added. Music for organ with pedal will usually consist of three parts: RH, LH and 

Pedal. 

 

Change part of notes 

If, in your opinion, the assignment of the notes to the LH and RH parts is incorrect, you can change 

it as follows: 

Select the notes that you want to assign to another part (with the Ctrl key pressed you can select 

several notes at the same time) and press the RMB. In the Context menu that you now get, choose 

"Move to part ->". You will see an overview of the other parts there, choose the desired part. 

 

Listen 

If you want to listen to the music you have entered, each part must have its own MIDI channel, 

starting with Channel 1. You can then connect an instrument from the list to that channel. 

Play: press the green triangle in the “Record / Play” toolbar. 

 

Note: 

The instruments in the MIDI system are numbered according to international agreements, the 

numbers of the instruments used here are indicated in the "Elements" list under "Type", "Program". 

Unfortunately, not every manufacturer complies with international agreements, some start counting 

with 000, others with 001. The result is that eg. "String orchestra" or "Strings" sometimes gets the 

number 048 (in KS) and sometimes the number 049. Take this into account. 

 

Add 

This allows you to insert an additional voice. If you want this part to be displayed on a separate solo 

bar, then you must choose a template with solo bar. 

 

 

2.4.2  Template button  
A template is a variation of the klavar staff to suit the specific needs of a certain musical instrument. 

Make a choice and click on “OK”. The template can usually be changed later while keeping all of the 

notes already inserted. 

 

 

2.4.3  Elements button  
This gives you the “Music Elements” menu, a list of data that together shape the music piece. 

 

Measure tick 

This column shows where the mentioned elements are. 

 

Part 

Here you can see to which part the element belongs. You can get an overview  with the button . 

 

MIDI Channel 

This is the MIDI channel on which this part is played. In the "Parts" menu you can link an instrument 

to this. 
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2.4.4  Zoom menu 

 In this menu you can set the desired magnification on your screen. 

 

 

2.4.5  Full Page button 

  A zoom factor is set such that the entire page is displayed. 

 

2.4.6  Page Width button 
 

 A zoom factor is set such that the  available width of the KlavarScript screen is fully utilized. 

 

 

* * * * * * * * * * * 

 

2.5 PLAY and RECORDING TOOLBAR 
 

 
 

You will find the usual Windows 10 symbols for playing your music here. 

 

* * * * * * * * * * * 
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2.6 SYMBOLS WINDOW 
   

To make a group of symbols visible in the "Toolbar Symbols", click 

on the "+" in front of that group with the LMB. 

 

Place symbols 

You cannot simply place most symbols anywhere, they must always 

be connected to a note or a counting line. You can then move the 

symbol by dragging it, with the  “Shift” key and LMB pressed to any 

desired position. 

 

Ctrl+C/Ctrl+V   Cut/Copy 

Be careful when using these functions, as this sometimes causes 

continuation dots to disappear. 

 

 

2.6.1  Note symbols (accents) 
If you want to place a symbol near a note, move the cursor to the name of that symbol that is then 

underlined. Then drag this with pressed LMB to the stem of the relevant note until a dotted bar 

comes around it, then release the LMB.  

 

If you want to provide many notes with the same symbol, you can do this as 

follows: with LMB pressed, select the group of notes (now turn blue) and then place the relevant 

symbol on one of the notes. The symbol then also appears with all other selected notes. 

 

Fingering notes 

You can bring a fingering from the list to the note, but it can also be done more simply: Activate the 

note and press a number. 

 

For more about the Fingering see chapter 3.3.10 Fingering 

 

 

2.6.2  Key symbol 
It is best to place this symbol at the beginning of the piece of music. Also see: 

W.J. Kaasjager, uitgave Klavarskribo Slikkerveer, Cat. nr. 24269”. (Dutch language) 

 

 

2.6.3  Dynamic signs 

Place and edit Crescendo and Diminuendo signs 

These signs are always automatically placed outside the bar, but when placing you must place the 

cursor inside the bar; a horizontal dotted line will appear in the bar that indicates the top of the 

character. The length of the sign is always one measure, but you can change that. 

 

Lengthen or shorten Crescendo and Diminuendo signs 

Click with the LMB on the sign until two blue blocks appear, above and below. Click with the RMB on 

"Properties" and adjust the length. Click "OK". 

 

Move Crescendo and Diminuendo characters 

Click on the sign until a dotted square appears around it. Now move the cursor with the LMB and 

Shift key pressed. The development of KlavarScript is not yet fully completed; the diminuendo sign 

can suddenly turn into a crescendo sign when moving. Click on the sign until a dotted square 

appears around it, press the RMB and choose “Properties”. At "Shape" you can set the correct 

character again. 

 

Alternative: 

Click on the character until a dotted square appears around it. Now move the cursor with pressed 

LMB and Shift key. 
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2.6.4  Tempo instructions 
You can change the text of these instructions by selecting “Properties” in the Context menu. 

 

 

2.6.5  TXT instructions 
There is only a limited number of text instructions available, but you can change a text once it has 

been placed. Place any text at the desired location, click on it with the RMB (Context menu) and 

choose “Properties”. You can change the text in the block that appears, then click on "OK". 

 

Delete text or symbols: 

- Activate the text or the symbol and click on the RMB. 

- In the menu that appears, select "Delete". 

- Or press the "Delete" key. 

 

 

2.6.6  Trills and Grace notes 
Always connect the trill to a note (dotted square around the note). The trill always has the length of 

one measure initially, but you can change that. 

 

Grace notes 

You can get a grace note from the “Trill” menu. Then a slur is also placed.  It is also possible to 

place one or more "loose" grace notes near a note. See for this chapter 3.3.7 Grace notes. 

 

Extend, shorten or move trills 

The same rules apply here as for the Crescendo and Diminuendo signs. 

 

 

2.6.7  Measure Symbols 
These are equal to those used in the traditional notation. 

 

 

2.6.8  Position and move lines (normal and dotted lines ) 
Get the line from the "Lines" menu and bring it to the desired location. The line is now selected (blue 

squares at the ends). You can change the length and location by placing the cursor on each of the 

blue blocks and bringing the correct position with the Shift key pressed. 

Unfortunately, Klavarscript places a normal line with both commands, so no dotted line. 

 

Place and edit 

Get the slur from the "Lines" menu and place it on the stem of the top note. 

Edit slurs 

Click on a place within the slur until three blue blocks appear, at the top, center and bottom of the 

slur. You can now change the size and shape by moving the blocks with the Shift key pressed and 

the LMB pressed simultaneously. By replacing the centre block you can change the shape of the slur. 

 

Place additional counting (or "beat") lines 

Open the "Lines" menu in the "Symbols Window". Take one of the beat lines (small, medium or 

wide) and place the dotted square that comes with it on the desired place. 

When you place an additional line where already was an automatic beat line, that automatic beat 

line will disappear. 

  

Delete automatic counting lines 

Some counting lines protrude so far beyond the beam that it is better to remove them from there. 

Open the "Lines" menu in the "Symbols Window". Take the "Remove automatic beat line" command 

and place the dotted square that comes with it on the counting line. 

 

 

2.6.9  Note Stem 
You can use the short stem to make the notes picture clearer. 

 

* * * * * * * * * * * 
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3 EXPLANATORY STATEMENTS AND OTHER SUBJECTS 
 

3.1 GRID - The minimum distance between notes 
For a number of operations it is necessary that you know the meaning of the terms "Grid" and 

"Number of ticks per quarter note". This is explained here. 

 

The notes cannot be placed on the bar at random places, but only on the "grid". This grid is an 

invisible vertical distribution of the staff that ensures that the notes are all neatly aligned. The step 

size, the distance between the grid lines, can be set with the buttons on the "Edit Toolbar". 

 

 "1" Means that the shortest possible note is a quarter note. 

 

 "2" Means that two eighth notes can also be placed on the space of a quarter note. 

 

 "4" Means that four sixteenth notes can also be placed on the space of a quarter note. 

 

 "8" Means that in the space of a quarter note, eight thirty-second notes can also be  

       placed. 

 "0" Means that there is apparently no grid, the notes can be placed anywhere. 

 

 

In reality there is still a grid, it is just so small that it is hardly noticeable. When a "New File" is 

opened in KlavarScript, the grid size (button "0") is 120. That means 120 "ticks" for a quarter note. 

 

When you point to a note with the cursor, you will see the details of that note at the bottom left of 

the screen, including the number of “Ticks”. 

Click on "Edit Music Elements" in this file  . In the list that you see, the duration of each note is 

indicated by the number of ticks. Each note that occurs in the piece is a multiple or part of those 

120 ticks. A half note is therefore 240 ticks, an eighth note 60 ticks, 1/32 note is 15 ticks. Shorter 

notes are therefore not possible here, because 1/64 note should be 7.5, but that is not possible. A 

1/64 triplet is just possible because that is 3 x 5 ticks. 

 

However, this number of 120 beats per quarter note is not fixed, but can vary per piece of music. All 

programs for the traditional Notation also use the "ticks per quarter note" system. 

You will usually use a file that comes from a scanning program, or a midi file. 

 

The number of ticks for a quarter note has already been recorded in those files, and KlavarScript 

takes over that number. The program that created your file determines the “number of ticks for a 

quarter note” based on the shortest note that occurs in that piece, or takes a safe large value that is 

never too small. 

 

MusicXML files can also be read by a word processor. If you double click on such a file it will be 

opened and you can read the code yourself. Somewhere at the top of that file, before the first 

<note> you see the command: 

 

<attributes> 

<divisions> XX <divisions> 

 

The number XX in this piece of music is the "number of ticks for a quarter note". 

 

If you enter a MIDI file in KlavarScript, the outcome is unpredictable because there are countless 

programs that create MIDI files. Sometimes you get a value that is close to a usable number, for 

example the value 239. However, this is a difficult value because it gives you unnecessarily many 

stop signs. In KlavarScript you can round this to 240. Select all notes using CTRL + A and then 

choose “Edit”  “Quantize and trim”. Sometimes the value 384 is used, which brings you the 

furthest with short notes and the corresponding triplets. 
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The results of some popular scanning programs: 

 

SharpEye  takes the value of the shortest note in the music piece, then it is not possible to enter 

notes in KlavarScript that are shorter than those in the original. 

 

PhotoScore Ultimate Same as SharpEye. 

 

SmartScore takes a larger number, if there are no triplets in the piece it becomes for example 20 or 

40. It is then NOT possible to place triplets later in KlavarScript because those numbers cannot be 

divided by 3. If there are triplets in the piece, then it will be 30 or 60, so you can place triplets in 

KlavarScript afterwards. 

 

CapellaScan takes the value 480, and that is almost always sufficient: 

1/128 note is 15 ticks, a 1/256 triplet is 3 x 5 ticks. 

 

The result of all this is that sometimes KS cannot afterwards enter notes that are shorter than the 

shortest in the original. But you can deceive the scan program or notation program by placing some 

shorter notes or triplets in it in advance. You can remove these later if necessary. 

 

 

* * * * * * * * * * * 

 

3.2 WINDOWS 
 

Multiple windows open at the same time 

When you have loaded a piece of music, click on the small box in the top right corner. Make this 

window smaller and open the next piece of music, also make it to the desired format. You can open 

a number of pieces and place them next to each other. If you want to edit a piece of music then you 

must first select it by clicking on the top bar, it will then turn blue, the others will be gray. 

 

 

* * * * * * * * * * * 

 

3.3 NOTES 
 

3.3.1  Split parts / Change stem direction  
If there are two parts on a beam (e.g. Left hand and Right hand) then these parts are 

distinguished by the "Stem direction". Changing the stem direction then automatically means that 

the note is brought to the other part. 

The button  "Split in left- and Right-hand parts" does not work properly yet , it's better to 

choose one of the following options: 

 

- To change one note: 

  Activate the note (dotted square) and press the space bar. 

- To change a group of notes: 

   Select the group (notes turn blue), press the RMB, choose "Move to part" and click on the desired 

   part. 

- To change entire part: 

Press the " Parts" button  in the "View Toolbar ", click on the relevant part in the "Part overview" 

(line will now turn blue), choose "Modify" and change the "Stem direction". Then "OK" twice. 
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3.3.2  Triplets and other antimetric figures 
If you use an .xml source file in which the antimetric figures are already present, they are usually 

correctly displayed in KS. If you use a midi file, the notes are often in the right place but are not 

indicated as an antimetric figure with a number (3 for a triplet). Also, the beam is usually not placed 

correctly over all notes. You can correct this as follows: 

Take in mind where the notes of the antimetric figure should be or print the page. 

Remove the notes from the antimetric figure. 

Click on "Note Edit" and then on "Antimetric figures". Indicate in the selection menu the 

amount of notes and over what duration, e.g. a triplet (3 notes) on 1 beat. Now place the first note 

of the figure in the right place, the others come underneath, but perhaps not yet at the right place. 

Click again to deactivate this function and then use the cursor  to move the notes to their 

correct position (pitch). 

 

If the first note of the antimetric figure is a continuation of the previous note, you can delete that 

first note in the usual way. The relevant part of the beam will remain. 

 

Sometimes an antimetric figure with many notes does not draw the correct number of notes, but it 

does state the correct number. This has to do with the minimum number of "ticks" per note, see the 

description "Grid". 

 

 

3.3.3  Continuation dots with triplets 
Sometimes when placing a (new) triplet, the continuation dots of a longer note also disappear and it 

is not possible to place new ones there. The note is now "shortened" and must get the correct length 

again. 

Activate the note and press the RMB. Then choose “Properties” with the LMB. In the “Change note” 

dialogue box that appears you can change the length of the note in “Duration:” Enter the desired 

number of ticks. If you do not know the correct number of ticks you can look it up by clicking on any 

note of the correct length an observing the number of ticks it has. For an explanation of the number 

of ticks, see chapter 3.1 Grid. 

 

 

3.3.4  Continuation dot after each measure line 
When a note lasts longer than the measure where it started, an extra continuation dot is placed 

after each measure line. If you want to remove these: 

- Click on "Edit Music Elements"   . 

- Select “Insert” (at the bottom of the Element List) 

- In the pop-up menu “Type” select “KS:Option” 

- In the upper field “Value” change “0” to “3” 

- Click “OK”, then “Close”. 

-  

This function is not included in the music file, but is stored within KlavarScript itself, so the change 

will apply to all files you edit afterwards. 

 

 

3.3.5  Change note length 
Activate the note and press the RMB. Then choose “Properties” with the LMB. In the block “Adjusting 

note” that now appears you can change the length of the note in “Duration:” Enter the desired 

number of ticks, if you do not know the correct number of ticks, you can look it up by clicking on 

any note of the correct length and observing the number of ticks it has. For an explanation of the 

number of ticks, see chapter 3.1 Grid. 

 

Alternative:  

Position the cursor on the note until a square dotted block appears around the note and press LMB. 

While keeping the LMB pressed move the cursor downwards until the right length of the note and 

release the LMB. 
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3.3.6 Notes at the end of the music 

Notes that extend to the end of the music have 0 ticks. The consequence of this is, among other 

things, that when playing the KlavarScript file in a MIDI player, the last note does not sound. 

If you have added an extra measure at the end of the music, these notes will also not receive a dot 

with each new measure. If you want these notes to sound, you must give them the correct length 

(=number of ticks): 

- Decide how many ticks the note should get; 

- Activate the note and press the RMB. Then choose “Properties” with the LMB. In the “Change note” 

  block that now appears, you can change the length of the note at “Duration:” Enter the desired 

  number of ticks and click “OK”. 

 

 

3.3.7  Grace notes / ornaments 
You can use two types of grace notes: 

1 - Grace notes that count on the timeline, those are assigned a certain number of ticks. These can 

only be placed ON the grid. 

To make these grace notes, place a regular note, place the cursor on this note and click on the RMB, 

then on "Properties". In the "Change Note" menu, select "Shape" and "Grace note (small without 

stem). These notes can also be heard during playback. 

 

2 - Grace notes that do NOT count on the timeline, those are NOT assigned a certain number of 

ticks. These too are placed on the set grid, but can also be placed out of the grid. These notes are 

NOT audible during playback. 

Click on  "Note Edit" and move the cursor to the place where the grace note should be. 

Click on the RMB and choose "Insert Symbol". Click at the "Major symbol" on the arrow and choose 

"Klavar grace note", then OK. You can copy these pre-positioned notes in the usual way with Ctrl + 

C and Ctrl + V. 

You can now change a black headed note to a white one or vice-versa by moving the note to a 

corresponding position on the bar. If you move such an note with the Shift key pressed, you can 

place it anywhere, but the note does not change from white to black or vice-versa. 

 

 

3.3.8  Arpeggio 
Arpeggio means that a number of notes on the same bar line are not played together, but shortly 

after each other, the lowest OR the highest first. In Klavarscore the notes have a skew stem. Go in 

the "Symbols window" to "Stem shape" and select the desired form. 

 

 

3.3.9  Glissando 
A glissando means that you go with one finger over all the white notes or black notes. The first note 

and the last note of the glissando are connected by a line. For a glissando you can use the "Normal 

line" in the "Lines" symbol menu. Select the end points and place them in the correct position with 

the Shift key pressed. 

 

 

3.3.10  Fingering 
Take the the cursor, activate or select the note, and type the number of the finger. 

 

Change fingering 

Activate the note and enter the new digit 1-5. 

 

Fingering with change of finger 

Activate the number, press the RMB, select "Properties" in the context menu and change the text. 

(thump is always No.1) Click OK. 

 

Move fingering 

Activate the number and press the space bar. 

Or: You can also move the digit with the Shift key pressed and the LMB pressed. 
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3.3.11  Double Notes 
 

If two notes are in the same place in the original music , as in the example below on the first bar of 

the bottom staff, then an error occurs in KlavarScript. 

 Each of the notes marked with a red arrow consists of quarter notes with sixteenth notes in the 

same place (as evidenced by stems coming out of the note head in both vertical directions). 

KlavarScript recognizes both notes, but in such a situation it makes the longest (quarter) equal to 

the shortest (sixteenth) when saving . 

 

After loading the original     If you have saved the file and 

.MID or .XML file you will see this:    open again later you will see this:  

    

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

After loading the original .MID or .XML file you will see in the Element list : 

 

 

 

 

 

 

 

So far the Klavar notation and the G2 notes in the element list are correct. The first G2 note is 120 

ticks (sixteenth note), the second G2 note is 480 ticks (quarter note). 

When you save the file and reopen it later, the top quarter notes for the left hand G2, A2 and B2 

appear to have disappeared. However, these notes are still in the element list, but the second notes 

(480 ticks) are made equal to the first (120 ticks). Even if you now make one of the two again 480 

ticks, this will cancel out when saving KlavarScript. 

 

One of the two notes G2 was 480 ticks long, and was made equal to the shorter (120 ticks) when 

saving. 

The bar now shows something different from the original. This is a BUG in Klavarscript. To be able to 

recognize and correct this error, it is very important that  sufficient knowledge of the traditional 

notation is required. 
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To permanently correct the error, search for the relevant note in the music bar. 

On the picture above you see two equal notes, one of which must be "changed back," no matter 

which. To do this, click on "Modify" at the bottom left of the Element list. You then get the menu 

"Change Note in Part......". Change the "Duration" to the correct value and also change the 

"Channel". The new value of this number (the MIDI channel) is not that important, it must be less 

than 16 in any case. Then click "OK". If you now look in the element list you will see: 

 

 

 

 

 

 

Repeat this operation for all notes that have been incorrectly changed. These new values will now be 

retained when saving. 

 

 

In the Universal Notation you can see that 

it is a double note, for two musical lines. If 

you think it is important that this is also 

visible in Klavarscore, you can choose a 

larger symbol for the note. In the Context 

menu (RMB) choose “Properties” → 

“”Shape” change from the longest note 

from "Normal" to "Large". You can then 

remove the shortest note, because it 

causes a messy image with the "white" 

notes. 

 

 

 

 

 

      Double notes invisible.        Double notes visible. 
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3.3.12  Overlapping Notes 
If in the original music two notes of the same pitch partly overlap, as in the example below, an error 

will occur in KlavarScript. 

 

 

 

 

The D-note on the top bar has a length of 3/4, 

the first note of the second triplet is also a D and 

overlaps the first D. 

 

 

 

 

 

 

 

 

 

After loading the original .MID or .XML file you will see this:  

This is correct, the first D (3/4) has the proper length. 

 

 

 

 

 

 

 

 

 

 

 

If you have saved the klavarScript file and reloaded it later, 

you will see the Klavar bar of the relevant piece as shown on 

the right. 

This is NOT correct, the first D (3/4) is shown too short 

 

The 3/4 note D now stops at the same moment as  the first note of 

the triplet, and is therefore displayed incorrectly. Perhaps not really 

audible for a pianist, but it could be a clearly audible error for an 

organist! 

 

This error can be corrected in the same way as the double notes: 

after correcting the length, give the longest note a different MIDI 

channel number in the element list or in the properties menu (click 

on the note, press RMB and change the channel setting). 

 

 

3.3.13  Chord symbols 
Place the cursor on the note with the chord symbol and press the first letter of that symbol. 

A field "Insert Chord" appears with the first letter already entered. Complete the symbol here and 

press "OK" or the "Enter" key. Use a "#" for a sharp and a "b" for a flat. 

 

If a part of the chord symbol is placed over the bar or crosses the lines, you can create a blank 

space around the symbol by placing the cursor on the chord symbol and choosing the context menu 

with the RMB. Then use the LMB to select "Edit profile" and remove the checkmark from the 

"Border" button. 

 

 

* * * * * * * * * * * 
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3.4 PARTS 
 

3.4.1  Shifting Part due to space on the stave  
It sometimes happens that the part for the left hand and the part for the right hand intersect. Then 

it is no longer clear to the player what belongs to what. In such a case, you can position the LH 

score one octave lower, and place the comment “Left Hand 8va” at the beginning of the music. 

Note: the following changes the notation, but for playback and in MIDI the notes remain in the same 

pitch. 

Select the box . Check the box for the part that you want to move and click on that part to select 

it. This line now turns blue. Select “Modify” and enter the distance to be moved under MIDI / Key 

Offset. If you want to list the part one octave lower, enter -12. Click on "Close" and in "Part 

Overview " again on OK. 

 

 

3.4.2  Change playback instrument  

Select the box . Under "Ins", double-click the instrument of the relevant part. Select the correct 

instrument under "MIDI instrument". 

 

 

3.4.3  Moving the pedal part Organ music 
Sometimes the pedal part in the TN is listed on the same bar as the LH part. You could use a 

separate pedal bar. 

1 - Press the button  and choose a template for organ with pedal. 

2 - You will then be asked "Do you also want to copy the part names and part settings from this 

     template?" 

     Select "Yes". 

3 - Press the  "Part Overview" button, choose Add 

     You now get the menu "Modify part parameters" and enter in it: 

 Part name:  "Pedal"  

 Bar assignment:  "Pedal" 

 Stem direction  "Left" 

MIDI instrument: Choose an instrument yourself 

Key Offset  0 

Channel   1 

Click "Close" and then "OK". 

 

Now select the notes that you want to move to the pedal bar (with the Ctrl key pressed you can 

select multiple notes at the same time) and press the RMB. In the Context menu choose "Move to 

part -> Pedal". 

 

 

3.4.4  Part numbers in Hauptwerk 
If you want to play the KlavarScript (MIDI) file on a Hauptwerk organ you must use the following 

part numbers (MIDI channel numbers): 

Pedal:   1 

Lower keyboard: 2 

Second keyboard 3 

Third keyboard 4 

 

* * * * * * * * * * * 
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3.5 MEASURES 
 

3.5.1  Upbeat (Anacrusis) 

Sometimes the space a whole measure is used for the upbeat, when it is better to represent only 

one or two beats. 

To remove the excess first part of the measure: 

- Klick on  and select the top part of the first measure, the part you want to delete. 

- Click on the RMB and choose “Delete”. 

- You will then get a window asking if you want to make an upbeat here: choose “Yes”. 

- If you want the measure numbering to start at number “0” for the upbeat, you can 

  indicate this in the menu “Layout” →”Measure numbers”. 

 

 

3.5.2  Increase or decrease measure dimensions 
The default size is 7.5 mm per quarter note.  

Click in the Menu bar on "Layout"  "Measure distribution". 

You get here the menu "Change KS: Measure setup", in which you can set the minimal size of one 

beat (is 1/4 note). But note: this only applies if the box "Do not stretch measures" is checked. If one 

of the other boxes is checked then the result becomes uncertain. 

 

If the box "Do not stretch measures" is checked then you can also increase or decrease individual 

measures or groups of measures, but be careful because this can lead to incorrect interpretation of 

the tempo by the player in Klavarscore . 

To do this, click on “Select measures”, indicate the upper limit by pressing the LMB and go to 

the lower limit. The selected sizes now light blue. Hold the cursor in the light blue part and click on 

the RMB. Click on "Size". Choose the size you want per quarter note. 

 

If you have adjusted dimensions in such a way, the "Stretch to create a full bar or page" function no 

longer works. 

 

 

3.5.3  Remove measures 

Click on “Select measure”, indicate the upper limit by pressing the LMB and go to the lower 

limit. 

The selected measures now turn light blue. Hold the cursor in the light blue part and click on the 

RMB. Click on "Delete". 

 

 

3.5.4  Insert measures 

Click on “Select measures” and select the entire measure above which you want to insert a new 

measure, this measure will now turn light blue. Press the “Insert” button or choose “Insert” from the 

Context Menu. 

 

 

3.5.5  Staff break 
Sometimes it is desirable that the break to the next page takes place at an earlier measure.  

Click on the + in the square box before the title "Measurement symbols", then on the " B Staff 

break" at the bottom of the list. Move the cursor to the B and drag it with the left mouse button 

pressed to the desired location. If you do not like the result, you can undo it again with the cursor 

on the B next to the bar, pressing the right mouse button and choosing “Delete”. 

The same rules apply to the other symbols in the symbol menu. You can also remove all symbols 

again by placing the cursor on them and choosing “Delete” with the right mouse button. 
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3.6 TEXT 
 

3.6.1  Title block 
The Title block is the part at the top of the first page where the name of the piece of music and the 

other information are. Click on "Layout" and then choose "Title and Copyright". 

In the "Document Properties" window you can enter the necessary data, then click on "Insert in 

document". This data is now placed on the upper part of the first page. 

 

If you think that the title block takes up too much space, you can make it smaller. You can move the 

texts with the cursor and hold the LMB: move the texts up a little so that space remains at the 

bottom of the title block. Now click on the "Add a floating textblock" button in the "Edit Toolbar". 

The borders of the title bar now become visible, small black square blocks appear on the corner 

points and in the middle of the four sides. Move the cursor exactly on the square in the middle of the 

bottom edge, so that the cursor changes to a two-point arrow. Now you can move the bottom edge 

up or down. Then click on the cursor button in the "Edit Toolbar". 

 

 

3.6.2  Place additional text in Title block 
You may want to place extra text in the title block, such as tempo, voice registrations for organs and 

other indications. To do this, click on the button "txt", "Add a floating text block" in the "Toolbar 

Edit". The borders of the title bar now become visible, small black square blocks appear on the 

corner points and in the middle of the four sides, but you don't do anything with that now! 

Draw with the cursor somewhere under the title bar, possibly in one of the staves, a rectangle large 

enough to place your text. Don't be shocked, the staff is pushed downwards, but that will be fine 

later! 

A "Rich Editing" window will also appear in which you can specify the font, font size, and alignment. 

Enter your text, possibly several lines. 

Then click on the cursor button in the "Toolbar editing". The "Rich editing" window disappears, but 

all text blocks are still highlighted. You can now make the text blocks larger or smaller as required, 

and possibly move your new extra text block to a location in the "Title and copyright" block. The 

pushed down stave comes back in its place. Then click the cursor button again. 

You can still move all text blocks afterwards by placing the cursor on them and moving them with 

the left mouse button pressed.  

 

 

3.6.3  Delete a text block 
Right click on it once and then choose "Delete". 

 

 

* * * * * * * * * * * 

 

 

3.7 LITERATURE 
 

Explanation of placing grace notes: 

KlavarScore website https://www.klavarscore.org/en/fbkpc80 or scan 

the QR code:  

 

 

 

 

 

 

 

 

* * * * * * * * * * * 
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